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Photo tools 2

Traditional film cameras and the photos they create are fast becoming a thing of the past. It's rare to see someone sitting around to make a photo album. We are increasingly sending photos to each other via email and sharing our memories online. Also, digital cameras are so easy to use that they take
more photos than ever before. Yes, the number of photos is increasing, but the importance of the memories they reflect has not diminished. In fact, it is as important as ever to make sure that our photos are well cared for. In addition, we still want to show off great images from our last trip in the easiest way
possible. If you haven't taken a leather album to a friend's house to show you photos of your European vacation, how do you share your photos? If you don't know how to launch a digital photo album, learn about the great tools for future photo albums. Content To launch a digital photo album, you must
first bring photos from your camera to your computer. Just connect the camera to the USB port of your computer. Usually, the software automatically uploads photos from the camera to the folder you set up on your computer. The advantage of moving automatically is that the images are already
organized. Your best bet is to get a digital album software that will help you upload your photos in an organized and efficient way. There are several options, including pisca and snapfish, which you can download and use for free. Label your photos, keep them chronologically, and look for programs that
you can easily access later. And most image software allows you to paste keywords and labels on your photos, so you can search for specific images by simply typing France 2009 if you want. Finally, if you put all your photos together in one place, you can quickly get rid of blurry shots and duplicates that
just take up space. Now you have the beginning of a lean average digital photo album [Source: Basic Digital Photos]. Advertising If you've ever worked on a computer, you know the horrible feeling of watching your work disappear in front of you because of some kind of malfunction. If you're writing term
paper or labeling a photo, losing that valuable information is beyond frustrating or depressing. But it is a feeling that can be avoided. That's where external hard drives comes in. An external hard drive is an additional place to store important information from your computer. It's isolated from your CPU, so
the bad thing that happens to your computer is leaving your external hard drive untouched [Source: Digital Photo 101]. Usually they will be plug and play, that is, all you really have to do is connect the hard drive to the computer and connect the resttook care of. Best of all, the price of your hard drive is
going down, but the amount of space you can get is increasing. So if you have a 2 terabyte (2,000 GB or more) hard drive, you can save more than 400,000 photos. What's the point of having all those photos if the ads don't intend to show them off? Don't be afraid: there are some great ways to keep your
photos digital and show them off whenever you want. You can also connect your camera directly to your TV, but you're losing the feel of the album you created on your computer. A better idea is to transfer albums to DVD using burn software. There are many programs that drag and drop files to write to
disk. Once that's done, you can pop the DVD on any standard DVD player, sit back and enjoy your photos on any TV [Source: Basic Digital Photos]. If you are looking for an easy way to share your photos advertising, you will get enough service to check out a variety of online photo albums available. It's
easy to use and allows you to access your photos from anywhere you have internet access. The first step is to enroll in the selected program. It's a simple process where you can upload photos. Some sites have limited space available. Free sites typically have more restrictions than subscription-based
sites. Ad Once you've uploaded your photos and organized them by date, put them in a folder and email them to friends and family. By doing so, you can save your photos in a localized location without worrying about searching your computer's hard drive. Plus, you can share your photos with anyone you
want [Source: Middleton Public Library]. One of the most important things about digital albums is to make sure they are backed up in at least one place. The last thing you want to do is try and find photos from your child's 5th birthday, to discover that they were accidentally deleted on the way. Once lost it
is very difficult to recover digital photos. Sure, the external hard drive we mentioned earlier is a good way to back up your photos, but going a little old school and making a hard copy doesn't hurt. That doesn't mean you need to print all the photos you own. No, the best way to save a hard copy of a photo
is to burn it to a CD or DVD. Today, DVDs are up to 8 GB in size, meaning they can hold a lot of photos. Write albums to disk, so no matter what happens to your computer or hard drive,Have your photos in places where electronic malfunctions can't touch them [Source: Digital Photo 101]. Do you have
tons of precious old movies, photos or VHS tapes sitting in boxes collecting advertising dust? Basic digital photography. Photo Software for Digital Images, 2009. (December 16, 2010). photography.com/photo software.html basic digital photography. Share digital photos using a TV 2009. (December 16,
2010). photo .com/display photo on tv.html digital photo 101. Tips for organizing digital photos 2010. (December 16, 2010). your digital photos.htmFlickr.2010. (December 17, 2010). Public Library. Online Photo Album, July 2007 (December 16, 2010). photo album-MID.pdfPicasa.2010. (December 17,
2010). (December 17, 2010) You've been taking digital photos with multiple system and camera upgrades for years, but now your collection is in turmoil. These free tools and techniques will fix your photo metadata, take out duplicates, reorganize folders and otherwise whisk digital photos into shape. The
goal here is to provide a fix for a common problem that plagues your photo collection, regardless of the type of photo organizer you're using or the type of data your digital camera provides. After this deduping, meta-tagging and folder pinning shape-up, you should be in a good place to keep your photos
organized with the methods and tools you choose. On Wednesday we asked you to tell us your favorite digital photo organization software. Read more Note: The main focus of this how-to guide is on Windows systems. However, each section offers Mac alternatives and suggestions. Another, more
important note: We strongly recommend that you back up your photos (at least to an external drive, ideally to offsite services like Mozy or Carbonite) before attempting to reorganize or modify them. That way, if you accidentally wipe out three years''s share of snapshots, you can be more confident in your
moves to clean things up, knowing that they're still sitting on a different drive. Fraudulent dates and other MetadataA folders full of 2009 vacation shots believed to have been taken on January 1, 2005? This is because the contents of the photos are embedded in exif data (metadata) and all kinds of
information about how, where and when the photos are taken. The camera can ruin this data like a photo application. Whatever the problem, Microsoft's Pro Photos software is a surprisingly robust tool to fix it. DragOr add a group of files, select individual photos (or all photos) and fix what needs fixing.
You can modify or add timestamps, location information, and more. Mac: ShootShifter free download has a dual role as a powerful photo name organizer as mentioned above, as well as unified with timestamp fixer. When you select a group of photos in ShootShifter and set a timestamp, that data is
locked to any photo program you are viewing. There are two types of duplicate photos that clutter your average hard drive removing tons of duplicates. One is the actual file replication, and another file name (which may end with (1) or copy, but is otherwise the exact copy of the image file that is the same
data package. The other is a photo duplicate — two shots taken in exactly the same location at about the same time, or the same shot that has been somehow resized into two separate files by the photo software. Duplicate files: If you can load photos multiple times from the camera or move a large
number of folders, duplicate the File Finder in the Image folder. The free version is powerful, speedy and accurate, so I like fast duplicate file finder (FDFF) on Windows. I run it in my wife's huge cache of photos from our wedding and found a photo of exactly the same size. FDFF also displays a preview of
the image files it detects, providing useful filters that can be applied to make very simple copies, such as when copying or deleting the most recent or oldest copy. Gina has previously covered and explained a whole bunch of free duplicate file tools, including the adly named Easy Duplicate Finder, which
WinMerge and our own avid photographer Jason regard as the best duplicate file tool they use. When your hard drive is cluttered with hundreds of files in folders, chances are. Read more Mac: What's useful in Python scripts is you can try Dupniator, but there's also a cross-platform duplicate file search.
There's a robust disk cleanup tool, Tydy Up!, with duplicate finders, but you'll have to pay $30 after a limited trial period. Duplicate photos: Duplicate files are the first step, but along with resized and cropped copies, there are almost a lot of the same takes scattered throughout the collection. To find similar
images, you can use several tools. Previously, we recommended DupliFinder as a great tool for scanning duplicate folders. But it's almost a little too thorough to match photos with something similar to a similar pixel feature. You can ignore these loose connections and sort matches by percentage, but to
have a little more control over how the search goes down, I recommend VisiPics (pictured above). It scans the actual photo content of each image file, so it may take some time to aggregate the survey results.I got a huge huge database, but I can run it in the background and do normal browsing and
work. Matches are shown together and a sliding scale of matching slack is provided, and while it is a shareware app with some locked features, it offers enough as a freeware app to do some serious cleaning. How do I start VisiPics? Select the photo folder from the list of the top center line, press the +

symbol on the arrow facing right to add it to the VisiPics queue, and press the Play style button in the middle to start scanning for duplicates. Note: If you previously used Picasa, iPhoto, or other photo management suites to organize and edit your photos, you may find a lot of photo duplicates. This is
because these applications create original folders to undo changes you make to your photos and make fast browsing using a cache of thumbnail images. If you're not using these apps and you're sure you don't want to undo these changes, go ahead and remove those folders and duplicates. Otherwise,
keep them and remove those folders from the search. Speaking of Picasa, Google's photo manager has a show duplicate photos option in the experiment menu, but it's just experimental and not clear about what you're trying to remove. You'd better go with an app that clarifies the results. Mac: Duplicate
Disappearer is a shareware plugin for iPhoto (and if you roll like that, Aperture 3) that scans the iPhoto database and, well, finds duplicates. It likes and offers commissioning for free. Whether it's photo software that controlled the import of cameras that understand those un organized folders with nonsensory names, or years of carelessness, it's likely that the photos folder is full of folders that use all kinds of naming schemes, or packed with schemes at all. In my case, F-Spot, Ubuntu's photo manager, has made it a good deal to give me a branch folder system for years &gt; months &gt; days. I'm not
a professional photographer who needs to make receipts or master discs for clients taken on a particular day and this is Pisceco Vacation 2008 or the ultimate barbecue road trip. On Makes little sense for my casual viewing of Windows, Mac and even Linux (in avoidance), it's Picasa to the rescue. We've
previously talked more about our organizational sessions with Picasa, but we'll use a much newer version of Google's Photo Organizer to show you a shorter version of the highlights. You need the same kind of facial recognition, name tagging, and a simple geographic location for Picasa 3.5. For more
information, on the Tools menu, select Folder Manager, and then look for folders that contain most of your digital photos. At the very least, while fixing this folder, click the button on the right to set Picasa to scan this folder all the time. Press OK at the bottom and grab a soda while Picasa works its way
through your photosOnce done, you will see a list of folders in the left panel. It may be an ugly sight, and if you haven't performed the timestamp correction above, Picasa's guesses about when the photo was taken could be completely turned off. Whatever the case in your folder, you are now going to give
your photos a new home. Move the View menu up and down to Folder View to try several different sorting methods. Think about how you organize your photos. If you plan to use Picasa, iPhoto, or other organizing software, you don't need to manually organize your photos by event rather than date. Even
better, both Picasa and iPhoto have facial recognition features, tagging/favorite systems, so you don't even have to create folders for a specific person's favorite shots. Organize your photos into meaningful folders to humans (Coastal Drive Weekend) for better search features and easy browsing. CNET's
Josh Lowenson used his mug as the standard for measuring facial recognition prowess. Read more Click on the folder in the left panel to jump to the main panel's sumnaire. If you have specific photos that belong elsewhere, select them individually (hold Control down and select multiple items), then press
the green Pin button in the lower left box (or press Ctrl+H on the keyboard to add them to the working group). Do you want to move the entire album? Once you have pinned the groups of photos that belong together, you can select them all from the tray of pinned items, drag them to a folder and copy
them there, and delete the folders that come from them. Do you need a new folder? With the pinned item selected, click the File menu, and then choose Move to New Folder. Picasa tends to help create new albums, a group of photos virtually linked together by Picasa, but not in the same place on the
hard drive. It's a kind of loose organization that got you here in the first place. When you're moving things around in Picasa, make sure you're actually moving between folders instead of albums. It takes a while, but by scanning Picasa's thumbnail images and pinning and moving the photos, you'll get a
meaningful collection for both the human eye and the photo organizing app. Once again, read our previous Picasa guide for a closer look at Picasa's organizing features. Have you thoroughly modified the photo book? Give us the story of your extreme photo library makeover in the comments. Comments.
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